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About the Contents of This Manual

This manual contains the basic operation methods for using VersaWorks to perform cutting with 
the GR2-640/540.
VersaWorks is not included with this product. The explanations in this manual assume that you 
own a Roland DG printer and that VersaWorks has already been installed.

About VersaWorks Help (Electronic-format Manual)

The operation method of VersaWorks is written in this manual. The VersaWorks help is a user's 
manual that you can view from your computer screen. The help can be viewed once the software is 
installed.
To display the help, perform the following operations.

Start VersaWorks, click the [Help] menu, and then click [Display Help].

Windows 11

From the [Start] menu, click [All Apps], and then from the list of apps (programs), 
click [VersaWorks] - [VersaWorks Help].

Windows 10

From the [Start] menu, click [VersaWorks] - [VersaWorks Help].

Introduction
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Check to make sure that you're using the latest version of VersaWorks. If VersaWorks is not the 
latest version, it may not be possible to perform cutting from the connected GR2-640/540.

•	 To perform this operation, connect the computer on which VersaWorks is installed to the Internet.
•	 If upgrading cannot be accomplished by following the steps described below, contact your 

authorized dealer.

Procedure

A	Start the VersaWorks update program.

Windows 11

1	From the [Start] menu, click [All Apps].

2	From the list of apps (programs), click [VersaWorks] - [Online Update].

Windows 10

1	From the [Start] menu, click [VersaWorks] - [Online Update].

2	When the [User Account Control] window appears, click [Yes] (or [Allow]).

B	On the [Settings] menu, click [Preferences].

Before Connecting the GR2-640/540
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C	Set the details for "Preferences."

1	To use a proxy server, select the check box and type in the IP address and port 
number.

2	Select the two check boxes, then choose "All Available updates."

3	Click [OK].

D	Click [Check for updates].

E	If the following window is displayed, click [OK].

You're using the latest version of VersaWorks.
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If the following window is displayed, update the software.

1	Select all of the check boxes that are available for selection.

2	Click [Update].
The update data is downloaded.

F	Click [OK].
When the [User Account Control] window appears, click [Yes] (or [Allow]).

G	Click [OK].

This completes the update of VersaWorks to the latest version.
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USB Connection

This section explains how to use a USB cable to connect the GR2-640/540.

Procedure

A	Install the Windows-based driver for the GR2-640/540, and then connect the 
GR2‑640/540 and the computer using a USB cable.
For information on installation, see the GR2-640/540 Installation Guide.

B	Check that the GR2-640/540 is on.

C	Start VersaWorks.

Windows 11

1	From the [Start] menu, click [All Apps], and then from the list of apps (programs), 
click [VersaWorks] - [VersaWorks].

Windows 10

1	From the [Start] menu, click [VersaWorks] - [VersaWorks].

The [Printer Settings] window appears. It appears only when the software starts for the first 
time.

Connecting the GR2-640/540
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D	Set the device to connect.

1	Select [Printer Driver], and then select the [Printer Name].

2	Click [Verify].
If the connection is established correctly, information pertaining to the GR2-640/540 such 
as "Model Name" and "Status" is displayed.

3	Set the [Nick Name].
If you do not set a nickname, the model name is displayed.

4	Click [Apply].
The information of the connected device appears in the [Printer List].

5	Click [OK].

This completes the preparations for cutting using VersaWorks.
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Ethernet Connection (TCP/IP Connection)

This section explains how to use an Ethernet cable to connect the printer.

Procedure

A	Perform all the preparations required for establishing an Ethernet connection, 
including installing the Windows-based driver. Then, connect the GR2-640/540 and 
the computer using Ethernet cables.
For information on configuring the settings and installation, see the GR2-640/540 Installation 
Guide.

B	Check that the GR2-640/540 is on.

C	Connect the GR2-640/540 and the computer (RIP server) to the network.

D	Start VersaWorks.

Windows 11

1	From the [Start] menu, click [All Apps], and then from the list of apps (programs), 
click [VersaWorks] - [VersaWorks].

Windows 10

1	From the [Start] menu, click [VersaWorks] - [VersaWorks].

The [Printer Settings] window appears. It appears only when the software starts for the first 
time.
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E	Set the device to connect.

1	Select [Printer Driver], and then select the [Printer Name].

2	Click [Verify].
If the connection is established correctly, information pertaining to the GR2-640/540 such 
as "Model Name" and "Status" is displayed.

3	Set the [Nick Name].
If you do not set a nickname, the model name is displayed.

4	Click [Apply].
The information of the connected printer appears in the [Printer List].

5	Click [OK].

This completes the preparations for cutting using VersaWorks.
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The term "cutting data" is used to refer to data that includes cutting lines. Use illustration software 
(such as Adobe Illustrator) to create the cutting data.
This section explains how to create cutting data using Adobe Illustrator and CorelDRAW, which are 
typical pieces of application software. However, this section assumes that you are already familiar 
with the basic operations of these pieces of application software.

Adobe Illustrator CC 2021/2022

1.	 Register the spot color.
Register in the swatch library the spot color to use for cutting lines.

A	On the computer on which VersaWorks has been installed, open the folder [C:\
Program Files\VersaWorks\Swatch\Illustrator].
This step requires administrator rights on the computer.
If you do not have these rights, ask the administrator to perform this work.

B	Copy the [Roland VersaWorks.ai] file to the [Swatches] folder in the folder where 
Adobe Illustrator is installed.
The folders under the Illustrator installation folder are composed as shown below.
Presets/(language folder, example: en-US)/Swatches

2.	 Create the cutting data.
Create cutting data, which includes the cutting lines.

A	Start Adobe Illustrator, and then create the illustration data.

B	Click the [Window] menu - [Swatch Libraries] - [Roland VersaWorks].
The [Roland VersaWorks] swatch library is displayed.

C	Select only the path that you want to make into a cutting line, and then select [line] 
in the tool palette.

Creating Cutting Data
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D	Select the swatch named [CutContour] in the swatch library.
The color of the specified path changes to [CutContour].

E	Save the data in EPS or PDF format.

CorelDRAW 2021/2022

1.	 Register the spot color.
Spot colors used for cutting lines are included in CorelDRAW 2021, so there is no need to register 
the spot color.

2.	 Create the cutting data.
Create cutting data, which includes the cutting lines.

A	Start CorelDRAW, and then create the illustration data.

B	Click the [Window] menu - [Dockers] - [Palettes].

C	In the Palette window, click [Palette Libraries] - [Spot] - [Roland], and then click 
[Roland VersaWorks] to turn it on.
The [Roland VersaWorks] palette is displayed on the screen.

D	Select only the path that you want to make into a cutting line, and then click 
[CutContour] in the [Roland VersaWorks] palette.

E	Click [File] - [Export] to save the file in EPS or PDF format.
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1.	 Determine the cutting conditions.
For the cutting conditions, you have to set appropriate values for each type of material. When you 
are cutting a material that you have never used before, use a piece of the material to determine 
the cutting conditions in advance.

If the media is frequently used and it is likely that the set conditions will often be used in the 
future, it is advisable to save the conditions on the machine. For details on how to do so, see 
"Using Presets" under "Cutting Efficiently" under "Optimizing Quality and Efficiency" in the 
GR2‑640/540 user's manual.

A	Operate the GR2-640/540 to perform a cutting test.
See "Performing a Cutting Test" under "Preparations before Cutting Output" under "Cutting 
Output" in the GR2-640/540 user's manual.

B	View the results of the cutting test, and then change the cutting conditions.
•	 Cutting force (pressure during cutting)
•	 Cutting speed (speed during cutting)
•	 Cutting-in amount (amount of blade extension)

For details on how to change the settings, see the linked items in "Adjusting Cutting Conditions" 
under "Preparations before Cutting Output" under "Cutting Output" in the GR2-640/540 user's 
manual.

C	Change the conditions, and then perform a cutting test again.

D	Repeat steps B and C until the cutting conditions are optimized.

Preparations for Cutting
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This section explains how to use the GR2-640/540 to cut material that has been printed with a 
printer.
The procedure explained here uses [Queue A] for the job queue folder as an example. When using 
a different folder, replace [Queue A] with the other one in this procedure.
Flatbed-type UV printers do not support printing followed by cutting.

1.	 Print with crop marks.
Add the crop marks for aligning the positions, and then perform just printing.

IMPORTANT: �Ensure there is a margin of 15 mm (0.6 in.) or more from the edge of the 
material.

When you are printing with a printer, set the margin from the edge of the material to 15 mm 
(0.6 in.) or more. If the margin is smaller than 15 mm (0.6 in.), the GR2-640/540 may not be able to 
read the crop marks normally.

A	Click  on the [Queue A] tab of the printer to use.
The [Queue A Properties] window appears.

B	Click .

C	Select the [Crop Marks (Print&Cut Alignment)] check box.

D	Click .

E	Select [Print Only] from the [Operation Mode] list box.

F	Click [OK].

IMPORTANT

If the source data for the job is an EPS file and a cutting line has been drawn around the border, 
configure the settings shown below before adding the job to the job list. If you do not configure 
these settings, a part of the border may not be cut.

1	On the [Queue Properties] window, click .

2	Enter a value of 0.35 mm (13.78 mil) or more for [Margin] under [EPS].
•	 If you enter a value less than 0.35 mm (13.78 mil), no margin will be added.
•	 If you configure the zoom in/zoom out settings on the [Queue Properties] or [Job 

Settings] window, the margin will also be zoomed in on/zoomed out from. When 
you add a job to the job list, a margin with the width set with [Margin] is 
automatically added within the range specified by the border.

G	Click [File] - [Add Job to Queue Folder] - [Queue A].
The [Open] window will appear.

H	Select the cutting data to add to the job list, and then click [Open].
The selected data is displayed in the job list. Select the data that includes the cutting lines 
(paths specified with CutContour).

I	Select the job to print from the job list, and then click .
The job is printed with crop marks.

Cutting after Printing
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2.	 Cutting the Printed Material
Load the printed material into the GR2-640/540, and then perform cutting.

A	Perform laminating or other required processing, and then load the material into the 
GR2-640/540.
See "Setting Up Material" under "Basic Settings and Operations" under "Basic Handling 
Methods" in the GR2-640/540 user's manual.

B	Display the [Job Settings] window.

1	Select a job that has been printed, and then drag it to the job list of the 
GR2‑640/540.

2	Select the job that you have dragged, and then double-click it.

C	If necessary, perform the operations shown below. 

Cut the border of the job regardless of whether a cutting line is present.

•	 Select the [Cut Image Boundaries] check box.

Set printer cutting conditions such as the blade force.

•	 Select the [Enable Advanced Settings] check box to enable the settings.

D	Click [OK].

E	Select the job to cut from the job list.

F	Click .
The printer detects the crop marks to adjust the position of the media, and then performs 
cutting. 
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